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SOFTWARE LICENSE AGREEMENT 
 
YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS.  YOUR INSTALLATION OF 
THE PROGRAM INDICATES YOUR ACCEPTANCE OF THESE LICENSE TERMS. 
 
PLEASE READ THIS AGREEMENT CAREFULLY BEFORE INSTALLING THE PROGRAM. 
SOLUSTAN, INC. WILL ONLY LICENSE THE PROGRAM TO YOU IF YOU FIRST ACCEPT 
THE TERMS OF THIS AGREEMENT BY INSTALLING THE PROGRAM. SOLUSTAN, INC.  
PROVIDES THE SOFTWARE FOR TRIAL FOR 30 DAYS OR 30 LAUNCHES OF THE 
DRIVER TO PROVE THE FUNCTIONING OF THE DRIVER ON YOUR PC BEFORE 
PURCHASING THE LICENSE. ONCE THE LICENSE IS PURCHASED, IT IS NON-
REFUNDABLE AND NON-RETURNABLE. 
 
These license terms apply to Your installation and use of the program, which program includes 
copyrighted materials and programs (collectively referred to as "Program").  This license is granted 
to You by Solustan, Inc. You may not use the Program contained in this Package to upgrade any 
existing Programs that You may have.  The Programs contained in this package are intended only for 
the New Users of LinkMotion software product line that user has purchased and not for any other 
use. 
 
1.   License.  This Program is licensed and not sold.  Title to the Program does not pass to You. 
Solustan owns copyrights in the Program.  You obtain no rights other than those granted You under 
this Program License Agreement.  The term "Program" means the original (including any revisions, 
enhancements, updates, or the like) and all whole or partial copies of it, including modified copies or 
portions merged into other programs.  You are responsible for the use of, and results obtained from 
the Program.  This Program may be used only on one machine at any one time.  You may not reverse 
assemble or reverse compile the Program, except as specifically provided by law, without the 
possibility of a contractual waiver.  You may not sublicense, rent, lease, or assign the Program. 
 
2.   Disclaimer of Warranty and Limitation of Liability.  THE PROGRAM AND ANY OTHER 
PRODUCT WHICH WE PROVIDE TO YOU AS PART OF OUR SERVICE ARE PROVIDED 
"AS IS."  EXCEPT AS SPECIFICALLY SET FORTH HEREIN, NEITHER WE NOR OUR 
LICENSORS MAKE ANY WARRANTIES, REPRESENTATIONS OR CONDITIONS OF 
MERCHANTABILITY, QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE 
RELATING TO OUR PROGRAM, SERVICES, AND/OR RELATED PRODUCTS THAT WE OR 
OUR LICENSORS PROVIDE.  
 
3.   IN NO EVENT SHALL SOLUSTAN BE LIABLE FOR ANY DAMAGES RESULTING 
FROM THE USE OR MISUSE OF THE SOFTWARE OR THE ACCOMPANYING MANUAL 
INCLUDING BUT NOT LIMITED TO DAMAGES FOR INJURY TO ANY PERSON OR 
PROPERTY. THE PROGRAM IS DESIGNED TO WORK WITH MACHINES AND AS SUCH, 
ANY PART OF THE SYSTEM MAY MISBEHAVE. IT IS IMPORTANT TO TAKE ALL THE 
NECESSARY PRECAUTIONS IN OREDR TO AVOID EQUIPMENT DAMAGE AND/OR 
INJURY. 
 
4.   WE DISCLAIM ANY WARRANTY OF TITLE OR OTHER WARRANTIES FOR ANY 
THIRD PARTY'S OFFERING(S) OR PRODUCT(S).  ALL SUCH WARRANTIES AND 
REPRESENTATIONS ARE HEREBY EXCLUDED.  WITHOUT LIMITATION, NO 
WARRANTY IS GIVEN THAT THE  PROGRAM OR PRODUCTS ARE ERROR-FREE. 
 
WE, INCLUDING OUR LICENSORS, DISCLAIM ANY LIABILITY OR RESPONSIBILITY 
ARISING FROM ANY CLAIM THAT YOUR ACCESS OR USE OF THE PROGRAM, 
SERVICE, AND/OR RELATED PRODUCTS WE PROVIDE INFRINGE ANY THIRD PARTY'S 
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INTELLECTUAL PROPERTY RIGHTS. 
 
IN NO EVENT ARE WE OR OUR LICENSORS ARE LIABLE FOR:  A) DIRECT, SPECIAL, 
INDIRECT, CONSEQUENTIAL OR INCIDENTAL DAMAGES EVEN IF WE HAVE BEEN 
ADVISED OF THE POSSIBILITY THEREOF INCLUDING, BUT NOT LIMITED TO, LOST 
PROFITS, LOST BUSINESS REVENUE, OR FAILURE TO REALIZE EXPECTED SAVINGS; 
OR,  B) ANY CLAIMS AGAINST YOU BY ANY OTHER PARTY.  This Section applies to all 
claims by You irrespective of the cause of action underlying Your claim, including, but not limited 
to:  a) breach of contract, even if in the nature of a breach of condition or a fundamental term or a 
fundamental breach, or b) tort including but not limited to negligence or misrepresentation. 
  
In no event are We or Our dealers liable for any damages arising from Your failure to perform Your 
responsibility in connection with this Program License Agreement, or arising from any cause beyond 
Our control, including but not limited to delay in the performance of Our obligations or misuse of 
Your User IDs. All limitations and disclaimers stated in this Section also apply to Our Product 
Licensors as intended beneficiaries of this Program License Agreement.  Any rights or limits stated 
herein are the maximum for which we are collectively responsible. 
 
5.  Termination.  This license is effective until terminated. This license will terminate immediately 
without notice from Solustan, Inc. if fail to comply with any of its provisions. Upon termination you 
must destroy the Software and all copies thereof, and you may terminate this license anytime by 
doing so. 
 
6.   General.   You are responsible for payment of any taxes, including Your personal property taxes, 
resulting from this Program License Agreement or Your use of the Program.  You agree to comply 
with all export laws and regulations.  Neither party may bring an action under this Program License 
Agreement more than ONE years after the cause of actions arose.  This Program License Agreement 
and all Your rights and obligations are governed by the laws of the State of Massachusetts. 
 
7.  LinkMotion driver software is protected with a software protection key. The protection key is tied 
to your specific PC computer using appropriate Microsoft Operating System. LinkMotion software 
license is non transferable. User will be required to pay full price for another license. It is very 
important to safeguard the PC with the license. 
 
8.  Free support for LinkMotion software is available for 60 days. User will have to pay for the 
support charge after 60 days of purchase.  
 
9. All of the above terms are effective for complete LinkMotion software product line. 
 
Solustan, Inc. 165 Chestnut St., #200, Needham, MA 02492  
Tel: 781-449-7666        EMail: support@solustan.com 
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LinkMotion for LinkCAM Detail Installation and Setup 
Instructions 
 
LinkCAM CD is available for an extra charge for 32 and 64 bit operating systems of Windows. 
Use 32 bit version for installing on Win 10, 8.1, 8 or 7 32 bit and Win XP operating systems. 
Use 64 bit version for installing on Win 10, 8.1, 8 or 7 64 bit operating system. 
 
Installation required for LinkMotion/LinkCAM driver for generating M & G Codes: 
 
Part 1 – Installing LinkMotion/LinkCAM on Windows 10, 8.1 or 8 requires to follow Disable 
driver signature requirement procedure just prior to installing LinkMotion. Then follow first part for 
installation of LinkMotion/LinkCAM software. Win 7 or XP users do not require Disable driver 
signature procedure so they can start installing LinkMotion software. 
 
Part 2 - Second part is Software license procedure. Full working version requires this procedure 
to remove the demo limitations as describe below.  
 
Demo Mode: 
LinkMotion/LinkCAM for M&G code software works in a Demo mode until sofware license procedure 
is completed. Demo mode has limitation of generating up to approximately 100 lines of GCodes from 
the design applications. It will not generate after it reaches 100 lines in one job. In demo mode only up 
to 140 lines of previously generated gcode files can be processed using GCode Files tab. 
 
Re-Launch LinkMotion means exit LinkMotion Icon from the systems tray on the bottom right by 
right mouse click and then launch it back on the systems tray by going to the Windows start button and 
All programs, Solustan, LinkMotion. 
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Part 1 – LinkMotion for LinkCAM Installation Procedure: 
 
Note that you must have administrative privileges on the computer or Administrator should install 
this in order to install LinkMotion properly. Please make sure that you are not running any software 
applications at the time of this installation. Virous protection softwares needs to be turned off 
before installing this software. You can turn that back on after the installation is finished. Most of 
the installation process is self-explanatory by following the instructions from the screen. You can stop 
the installation at any time by clicking "Cancel". 
 
Windows 10, 8.1 and 8 users should follow Disable driver signature requirement procedure just prior to 
installing LinkMotion software as explained seperately for each one in next few pages. Windows 7 and 
XP users can skip that part and go to LinkMotion installation part of the instructions. 
 
Installing on Windows 10, 8.1 or 8 operating system:        
 
Do not insert LinkMotion/LinkCAM for M & G Code software CD (if you chose to receive software 
on CD) until following procedure is done for Windows 10, 8.1 or 8. In Windows 10, 8.1 and 8 operating 
system, you must first disable the Driver Signature Requirement to install the LinkMotion driver. 
Once the Driver Signature Requirement is disabled the system will restart the computer and then user 
will be able to install LinkMotionLinkCAM driver using our installation instructions. Next time when 
computer restarts the Driver Signature Requirement will default back to enabled. Once the 
LinkMotion/LinkCAM driver is installed, you can install a new version of LinkMotion/LinkCAM 
without having to disable it again in Windows. We have included separate instructions for Disable driver 
signature requirement procedure for Windows 8.1 and Windows 8. Please follow proper instructions for 
your computers operating system. 
 
Windows 10, 8.1 and 8 user interface has newer design and it is different than all previous version of the 
Windows. There are more then one ways to go to the Control Panel and you should use what you are 
comfortable with. Control Panel can be selected by bringing the arrow of your mouse at the bottom right 
corner and select Settings. Under the settings, second available selection is Control panel. Click on this 
and all Control Panel selections are available. Remember to use apply button and save information when 
you make any changes in the settings for it to be effective. 
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Disable Driver Signature Requirement under Windows 10: 

Go to Windows Settings dialog box by one of the following methods: 

(1)� Click on the Windows Start button and select Settings. 
(2)� Select All Apps selection above the Start button of Windows and select Settings. 
(3)� Click on the No New Notification icon on the Systems Tray at the bottom right. Here click on 

the All Settings. 

You will see the dialog box for Settings as shown below. 

 

Click on the Update & Security, Windows Update, Recovery, Backup and you will see the following 
options shown in the picture below.

 

Select Recovery on the left side and Click on the Restart Now button under Advanced startup on the 
right side. 
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Here select Troubleshoot. 

Select Advance Options under Troubleshoot selection. 

Select Startup Settings under Advanced Options selection. 

Select the Restart button from the bottom right under Startup Settings selection. 

Now Computer will restart again and you will see a screen for Startup Settings with many selections 
available listed with numbers One through Nine as shown in the picture below. 

Press F7  key on your computer keyboard when you see the screen as shown above. This will disable 
the Driver Signature Requirement. After you press F7 key your computer will start launching the 
operating system. After your operating system is launced follow the normal login procedure and install 
LinkMCAM driver by following the installation instructions from the documents provided by Solustan. 

If for any reason you had to restart your computer before installing LinkMotion/LinkCAM you 
need to start the Disable driver signature enforcement procedure again before you can install 
LinkMotion/LinkCAM. LinkMotionLinkCAM printer driver for generatin M & G Codes will be 
installed only if this procedure is followed properly. 
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Disable Driver Signature Requirement under Windows 8.1: 

Open the Charms Bar in Windows 8.1 by bringing the arrow of your mouse on the bottom right corner 
of you computer screen and select Settings (first at the bottom) as seen on the picture below. 

 

Once Settings is selected you will see the following screen and select Change PC Settings as shown 
below. 

 

Under Win 8.1 when Control Panel opens, select Update & recover section from the left side as shown 
in the picture below. 
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Under Win 8.1 Click on the Recovery option on the left side as shown in the picture below. Once 
selected, you will see an Advance startup section on the right side. You will need to click on Restart 
now button. 

 

Now your computer will restart. Once the Computer has restarted, Choose an Option selection will 
be available. Here select Troubleshoot. 

Select Advance Options under Troubleshoot selection. 

Select Startup Settings under Advanced Options selection. 

Select the Restart button from the bottom right under Startup Settings selection. 

Now Computer will restart again and you will see a screen for Startup Settings with many selections 
available listed with numbers One through Nine as shown in the picture below. 

 

Press F7 key on your computer keyboard when you see the screen as shown above. This will disable the 
Driver Signature Requirement. After you press F7 key your computer will start launching the operating 
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system. After your operating system is launced follow the normal login procedure and install 
LinkMotion driver by following the installation instructions from the documents provided by Solustan. 
 
If for any reason you had to restart your computer before installing LinkMotion/LinkCAM you 
need to start the Disable driver signature enforcement procedure again before you can install 
LinkMotion/LinkCAM. LinkMotionLinkCAM printer driver for generatin M & G Codes will be 
installed only if this procedure is followed properly. 
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Disable Driver Signature Requirement under Windows 8: 

Open the Charms Bar in Windows 8 by bringing the arrow of your mouse on the bottom right corner of 
you computer screen and select Settings (first at the bottom) as seen on the picture below. 

 

Once Settings is selected you will see the following screen and select Change PC Settings as shown 
below. 

 

Under Win 8 select General from the left side as shown in the picture below. 

 

Under Win8 Scroll to the bottom of General and select Restart Now under Advanced Start-Up  from 
the right side as shown in the picture below. 
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Now your computer will restart. Once the Computer has restarted, Choose an Option selection will 
be available. Here select Troubleshoot. 

Select Advance Options under Troubleshoot selection. 

Select Startup Settings under Advanced Options selection. 

Select the Restart button from the bottom right under Startup Settings selection. 

Now Computer will restart again and you will see a screen for Startup Settings with many selections 
available listed with numbers One through Nine as shown in the picture below. 

 

Press F7 key on your computer keyboard when you see the screen as shown above. This will disable the 
Driver Signature Requirement. After you press F7 or 7 key your computer will start launching the 
operating system. After your operating system is launced follow the normal login procedure and install 
LinkCAM driver by following the installation instructions from the documents provided by Solustan. 

12



If for any reason you had to restart your computer before installing LinkMotion/LinkCAM you 
need to start the Disable driver signature enforcement procedure again before you can install 
LinkMotion/LinkCAM. LinkMotionLinkCAM printer driver for generatin M & G Codes will be 
installed only if this procedure is followed properly. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

13



Install LinkMotion driver software for generating M & G Codes: 

If you have received the driver software on a CD then follow steps from (1A). If you have received 
it by internet then follow the steps from (1B). 

(1A) Insert the LinkMotion/LinkCAM installation CD into your CD-ROM drive. If the Auto-run 
feature is enabled, Windows will start the Installation automatically. If the Auto-run feature is not 
enabled, browse the CD drive in Windows explorer and double-click on the "LinkCAM32_Setup,exe"  
or “LinkCAM64_setup.exe” and installation will begin.  

Or 

(1B) After downloading, unzip the files and save them by creating a folder name LinkMotion. Now 
double click on the file name  "LinkCAM32_Setup,exe"  or “LinkCAM64_setup.exe” and installation 
will begin. 

(2) Click on the Next Button. 

(3) Click on the Next Button. 

 

(4) When you get to the License Agreement dialog (see above), you must read the agreement. If you 
agree, go ahead and click the radio button, "I Agree" for the installation process to continue and 
Click on the Next Button. 
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(5) After you have read and agreed to the License Agreement, you will be asked to specify the 
installation folder. In most cases you can leave this as the default setting. 

 

(6) Click on the Next button once again. 
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(7) Later during the installation you will see Choose your machine name for installation. The default 
machine name is RS274/M&G-Codes. Scroll on the arrow to the right and more machine names are 
available. Please choose your machine name. If you wish to add your machine name that you do not 
see here, Please contact us. Do not create or write new machine name here at the time of this 
installation. 

 

(8)  You will see a message shown below before this installation is complete. Here select Install this 
driver software anyway to make sure that LinkMotion printer driver for your machine gets installed 
properly. Name of the printer driver will be the name of the Machine you select from the above 
selection. Sometime this message may appear in the background of another message and you need 
to make sure to bring the in the foreground and make proper selection for Installing this driver 
software anyway is done. It will not install the printer driver if this was not followed properly. 

 

(9)  Message displayed below is a reminder to Re-launch Linkmotion one time after installation is 
finished for the driver to be recognized properly and Click on the OK button here. Make sure to click 
on the OK button after you click on the “Install this driver software anyway”. 
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(10) Click on "Close" when the installation is complete as shown below. 

 

Icon shown below should show up in system tray at the bottom right. If LinkMotion icon does not show 
up in the systems stray in case of Win 10, 8 and 7 follow directions from below and setup to view that 
icon all the time. 

Go to Control Panel of windows from the Start button. Click on the Appearance and 
Personalization. Go to the Taskbar and Navigation(Win 10), Taskbar(Win 8), Taskbar and Start 
Menu(Win 7 and XP). Click on the (Notification area on Win 10) Customization on the taskbar.  
Win 10 - Click on Select which icons appear on the taskbar. Hereckeck LinkMotion icon to be on. 
Win 8, 7 - Here click on the box at the bottom left for Always show all icons and notifications on the 
taskbar. Click on the OK button. 

 

To view all different files and folders that is installed for LinkMotion one more setup is necessary 
using following directions in Win 10, 8 and 7:

Go to Control Panel and click on the Appearance and Personalization. 
Under Folder Options Click on the Show Hidden files and folders. 
In the View section, look for Hidden files and folders. 
If not checked already, check the button for Show hidden files, folders and drives. 
Click on the Apply button. Click on the OK button.  
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(10) Setting up the Default Printer: 
You want the LinkCAM printer to be your default printer. Go to the Start button and open the "Control 
Panel>Printers and Faxes" menu and find the printer driver with RS274-M&G-Codes name as shown 
in the picture below. Right click on this printer and select "Set as Default Printer".  

(11) Setting up the printer properties: 

You want the LinkMotion printer to be your default printer. Open the Control Panel > View devices and 
printers(Win 10, 8 or 7) or Printers and Faxes menu(Win XP) and find under printer “RS274-M&G-
Codes” name as shown in the picture below. Right click on this printer and select "Set as Default 
Printer". This name may be different if you selected your machine name. We give you a choise for 
selecting the machine name at the time of the installation with a scrolling arrow on the right side. 
Do not create or write your own new machine name here at the time of this installation. 

(13) Multiple users: 

Under Windows 10, 8.1, 8 and 7 LinkMotion version 4.06 onwards allows multiple users to use 
LinkMotion for the same computer. Installation of the LinkMotion.INI and temp.txt file locations 
have been moved in the following locations: 
C:/ProgramData folder > Solustan folder > LinkMotion folder > LinkMotion.INI file and bmp files. 
Previous user should always log off before another user logs on and start using LinkMotion. 

Under Windows XP version 4.06 onwards, LinkMotion.INI and temp.txt files are installed in the 
following locations:  
C:/Document and Settings folder > All Users folder > Solustan folder > LinkMotion folder > 
LinkMotion.INI file. 
Windows XP has the limitation to allow only one user to use LinkMotion properly. Please make 
sure to install properly for one user only. 

(12) International Customers need to check following: 
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If you are using Windows operating system for other languages please make sure that following settings 
are selected for LinkMotion to work properly. 
 
Win XP:  Go to the Start button > Control Panel > Regional and Language Options > Click on the 
Customize button. Here Decimal Symbol should be .(Full stop or Period) selected. Do not select 
,(Comma). If you had to change click on the Apply button and Click OK.  
 
Win 10, 8 users need to figure out to see the Control Panel and then follow Win 7 instructions. 
Win 7 32/64:  Go to the Start button > Control Panel > Clock, Language, and Region > Change 
keyboards or other input methods > Select Format tab(menu) > Click on the Additional settings 
button. Here Decimal Symbol should be .(Full stop or Period) selected. Do not select ,(Comma). If you 
had to change click on the Apply button and Click OK.  
 
You are done with all settings for windows. LinkMotion installation procedure is complete. Refer to the 
LinkMotion/LinkCAM manual for additional information on the operation and setup of the 
LinkMotion/LinkCAM software. 
 
Also, refer to design application you are using and how that works with LinkMotion and Popular 
Applications. Document names are as following: 
 
LinkMotion and Corel Draw 
LinkMotion and Illustrator 
LinkMotion and Auto Cad and More ……. 
 
Re-Launch LinkMotion: 
It is extremely important to Re-Launch LinkMotion first time after installing and then if you 
replace or change LinkMotion.INI file for it to be effective.  It is also important to Re-launch when 
you change the machine’s table size or DPI selection in the  
 
Exit the LinkMotion (icon) applet by right mouse click from the systems tray at the bottom right.  
LinkMotion icon should go away from the systems tray. 
 
Now launch it back again by following and selecting the path Windows Start button>Program 
Files or All Programs >Solustan>LinkMotion by the arrow of your mouse. 
 
LinkMotion icon should appear again in the systems tray at the bottom right. 
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Uninstalling LinkCAM: 
 
Please make sure of the following before you Un-Install and Re-Install: 
 
Your specific machine related settings are saved as LinkMotion.ini file. This file can be saved from 
General Options Menu and simply click on the Save button. It is preferred that you give this file a 
unique name and save it properly to make it easy to retrieve it in future. Different users can save under 
different names. Similarly you can Load that file back after another installation of LinkMotion by going 
to the General Options menu in LinkMotion and clicking on the Load button. Restore Default button 
allows you to load default original INI file that is supplied with LinkMotion. It is very important to 
exit LinkMotion applet and Re-launch the applet when you make any changes for it to be 
effective. Understand the definition of Re-Launch from below. 
 
LinkMotion is a Windows compatible driver. It does not need to be install or uninstall frequently.  
However, if it is required to re-install the driver, the following are useful pointers to remember. 
 
There is not any easy way to remove and install new version of the driver in Win XP operating system. 
It is necessary to go through uninstall described in our documents. Additionally, there may be a Need to 
manually remove Files from various Windows directories in the PC. 
 
Both, Win 10, 8, 7 32 and 64 bit versions are well organized to make fresh installations of the same or 
newer versions of LinkMotion. 
 
1. It is not proper and will not help to uninstall and install the same version of the LinkMotion one after 
another, if you find it to be not working properly. 
 
2. Windows 10, 8 and 7 does not allow removing of an installed driver and re-installing of the same 
driver unless necessary changes are made to the driver installation software. 
 
3. In case of going back and forth between earlier and newer driver software, the system may be armed 
with incompatible versions of the driver and applet. This is likely to cause more problems. 
 
4. Once a driver is installed in Win 10, 8 and 7 system, it is permanent. The driver cannot be unloaded 
easily. The operating system is more robust and more stable as a result. 
 
5. The best thing to do is to understand the structure of the driver. It is dictated by Windows and 
Microsoft web sites can be very useful in understanding drivers. 
 
6. We will only discuss what is important here. Every driver is made available with a LMVC64*.inf file. 
This file controls the installation of the driver. 
 
7. Once you install a LinkMotion driver, a driver instance is created in the appropriate folders of 
Windows 7 system. If it is needed to re-install LM USB or LinkCAM, take the following steps: 
 
A. Open the file LMVC64.inf  in any editor. 
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B. Find the line “DriverVer=06/24/2011,1 “ with the date and installation number. 
 
C. If possible, change it to today's date. 
 
D. If it is the same date, change the number at the end of the line. 
 
E. Save the file. 
 
F. Now, when you unistall, the older installation, it will remove applet and other files. However, it will 
archive the last version of the driver. 
 
G. The new installation will install new version of the driver as long as the date or the instances are 
different and newer than the previous installation of the driver. 
 
H. There is going to be matching driver and applet in the system. 
 
J. It is important to make sure that the firmware in the USB controller matches the proper version of the 
LM software. 
 
 
Uninstall LinkMotion/LinkCAM Procedure: 
 
Make sure the LinkMotion applet is closed. Open the Start menu and select the Control Panel. 
Double-click on Add or Remove Programs. Look for LinkMotion entry in the list and click on that. 
Select "Remove" and answer "Yes" when it asks you if you really want to remove LinkMotion. 
 
LinkMotion.INI file (configuration file) does not get deleted with uninstall procedure.  
 
If you want to delete your existing INI file following is the procedure for Win 10, 8 or 7: 
 
LM version 4.06 and higher: C:/ProgramData folder > Solustan folder > LinkMotion folder > 
LinkMotion.INI file and bmp files. 
 
LM Version 4.05 and lower: In the C:\ hard drive Find folder name Users> Folder with users (your 
own name) name> Folder name AppData> Folder name Roaming>Folder name Solustan> Folder 
name LinkMotion> LinkMotion.INI. Delete this file. 
 
If you want to delete your existing INI file following is the procedure for Win XP: 
 
LM version 4.06 and higher: C:/Document and Settings folder > All Users folder > Solustan folder > 
LinkMotion folder > LinkMotion.INI file. 
 
LM Version 4.05 and lower: In the C:\ hard drive Find folder name Document and Settings> Folder 
with users (your own name) name> Folder name Application Data> Folder name Solustan> 
Folder name LinkMotion> LinkMotion.INI. Delete this file. 
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Read and understand detail from the full manual before operating your LinkCAM 
driver software for generating M & G codes for CNC machine product. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

22



Part 2 – Software License Key Procedure: 

After installing LinkCAM software  user needs to double click on the LinkMotion Icon on the systems 
tray at the bottom right. Here click on the Help Tab and you will see the following picture. 

LinkCAM in Demo Mode: 

LinkMotion/LinkCAM for M&G code software works in a Demo mode until sofware license 
procedure is completed. Demo mode has limitation of generating up to approximately 100 lines of 
GCodes from the design applications. It will not generate after it reaches 100 lines in one job. In demo 
mode only up to 140 lines of previously generated gcode files can be processed using GCode Files tab. 
If code generated is larger then user will see the following message:

 

User needs to send proper Hardware ID that you read here to support@solustan.com. You can use 
windows copy and paste method or make sure you send it to us without any error.  

Solustan will not be resposible for any errors generated by user. It will cost you extra in case of an 
error where we need to generate sofware key more than once. 

We will send back the Sotware Key code that you will place in the secon box and then click on the 
button for Register. You will see the following screen once license is registered. Now sofware will work 
with all functions properly. Following picture shows software without full license. 
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Once you receive a license key code from Solustan and it ets registered it should display as seen in the 
following picture. 

 

Now start using the software and enjoy generating gcode files. 
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LinkCAM for generating M & G-Codes (plus DNC): 
 
 
LinkCAM for M and G-Code software driver allows the user to design a job in a program like Corel 
Draw, AutoCAD, and other qualified programs. Simply Click Print to send the job to the LinkMotion 
driver to Generate, Save and Send M & G-Codes. 
 
(1) Generate and Save M & G-Code files: 
 
To Generate and Save G-Code file, simply, click Print from your job design program. In a default 
mode, the G code file will be saved as text file (*.txt). It will be saved in the default folder location set in 
the ‘Saved file path’ setting in the General Options tab.  
 
Simply, double click to open the file in the default editor of Windows. Also, user can open the file and 
edit it in Microsoft NotePad, Microsoft WordPad, Microsoft Word, or most any popular text editors. 
 
Many existing CNC controllers require specific file extension (instead of txt) such as *.ngc, *.cnc, 
*.ncd, *.tap, etc. User can change the extensions in many different ways. Remember, the file extension 
needs to be changed only if you plan to use the proprietary software provided by the controller 
manufacturer to send the file to the controller. You need not worry about the extension if you use 
LinkMotion DNC capability to send the file for processing. 
 
A. Open the file, edit if necessary, and finally, select Save As . . in the File menu of the editor. Enter 
name and extension suitable for the job. This is true in any version of the Windows operating system. 
 
B. Windows 10, 8, & 7 32/64 
User can change the default extension from *.txt to one suitable to meet the need in the LinkMotion.ini 
file installed in the computer. 
 
Locate the file LinkMotion.ini in the following location: 
 
In the C:\ Program Data > Solustan > LinkMotion > LinkMotion.INI.  Double click to open the file 
using NotePad.  
Scroll down until you fine a line name under your selected Machine name  
“GcodeFileExtension=.txt”. 
Change from .txt to extension required by your machine controller like .ngc, .cnc, .ncd, .tap etc.  
Save it. Re-launch LinkMotion by right mouse click on the Linkmotion Icon at the bottom right in 
Syatems Tray and select Exit. Launch it back from the Windows Start button, Select All Programs > 
Solustan > LinkMotion. 
 
C. Windows XP  
User can change the default extension from *.txt to one suitable to meet the need in the LinkMotion.ini 
file installed in the computer. 
 
Locate the file LinkMotion.ini in the following location: 
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In the C:\ Documents and Settings> All Users > Solustan> LinkMotion> LinkMotion.INI. 
Double click to open the file using NotePad.  
Scroll down until you fine a line name under your selected Machine name  
“GcodeFileExtension=.txt”.  
Change from .txt to extension required by your machine controller like .ngc, .cnc, .ncd, .tap etc.  
Save it. Re-launch LinkMotion by right mouse click on the Linkmotion Icon at the bottom right in 
Syatems Tray and select Exit. Launch it back from the Windows Start button, Select All Programs > 
Solustan > LinkMotion. 
 
(2) Send job to controller Using Com port (using DNC facility): 
 
Note the following rules and settings for successful transfer of files from Win XP and Win 7 32/64 
operating systems based PC to the CNC controller equipped with serial port: 
 

A. It is likely that newer PC’s may be equipped with only USB ports and your CNC controller may 
have only serial or parallel port. Please, get in touch with us for proper USB to serial or parallel 
port cables along with proper software. 

B. It is best to set up a folder directly in the C:\ root directory. Our DNC software will be able to 
pick up files from this folder without any problems. 

C. It is best to assign a file name with 8 characters or less followed by a three letter extension 
appropriate for your CNC controller. 

D. Select COM1, COM2, COM3, or COM4 in ‘Send file to port’ selection in General Options 
tab. User selects the COM port where the CNC controller cable is connected.  

E. Set the configuration of the COM port within Windows to match with the COM port setting of 
the CNC controller. The instructions are slightly different for different versions of the Windows 
operating systems:  

 
COM port setting under Windows 10, 8, 7 32/64 
Click windows Start button. Select Control Panel.  
Select Hardware and Sound.  
Select Device Manager from Devices and Printers.  
Double Click on Ports (COM & LPT) (Port information is displayed only if a device is connected). 
Double click on the COM Port where your controller is connected.  
Select the tab for Port Settings.  
Setup Bits per second, Data bits, Parity, Stop bits, and Flow control to match with CNC controller. 
Click OK to save those settings. 
 
COM port setting under Windows XP 
Click windows Start button. Select Control Panel.  
Double click on Administrative Tools.   
Double click on Computer Management.  
Select Device Manager on the left.  
Double Click on Ports (COM & LPT) (Port information is displayed only if a device is connected). 
Double click on the COM Port where your controller is connected.  
Select the tab for Port Settings.  
Setup Bits per second, Data bits, Parity, Stop bits, and Flow control to match with CNC controller. 
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Click OK to save those settings. 
 
As soon as you click ‘print’, G code file will be saved and sent to the CNC controller. 
 
(3) Send previously saved G-Code or 3D-Gcode files to your G-Code compatible controller: 
 
Proper communication port setting is required as explained in number (2) above to send previously 
saved M and G-Code files to your controller. 
 
If you first simply saved the M and G-Codes you can open these files for editing. After editing you 
should Save this file. Once saved you can simply go to G Code Files tab of LinkMotion and navigate to 
where you have saved this file. Select the file and Click on the Open button at the bottom right and 
LinkCAM will send the file to your controller.   
 
LinkCAM’s printing the G code capability allows creation and sending of 2 1/2D G code files. These 
files cab be saved and sent later using LinkCAM. Additionally, 3D G code files can be created 
elsewhere and can be sent to the controller using LinkCAM’s DNC capability. 
 
When processing G Code files using this method user need to check the first and the last Z move 
in those files and make sure that tool is parked properly for making that first Z move along with X 
and Y parking postion should be confirmed relative to the move generated in your G Code file. 
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Welcome Screen: 
 
 

 
 
 
The LinkMotion and Solustan logo in the main screen is a ‘Hot Zone’. If your computer is connected to 
internet and if you click on the Hot Zone, you will be able to connect your computer directly to the 
Solustan web site. Currently, there are many design application working with LinkMotion manuals 
available on the web site that can help user further understand the operation of the product. Please make 
sure to refer to them before using LinkCAM. 
 
User can also download the manual from www.linuxcnc.org/docs/EMC2_User_Manual.pdf. This has 
complete explanation for M and G-Codes. LinkCAM and Solustan’s USB controller complies with 
EMC2 G codes. 
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Materials Properties: 
 
 

 
 
 
Material: 
 
Pull down the Material Properties menu to observe a selection of various materials. Pre-select the 
values of speed and tool positions for each of the materials. LinkMotion/LinkCAM can be employed to 
work with many different types of machines. Hence, there is no single value appropriate for all different 
machines. User’s experience will dictate the values for his/her machines. 
 
The values can be inches per second or millimeters per second or centimeters per second. General 
Options menu allows you to make your selection for this measure of units. You can override the any 
setting by changing it while the material is selected. Click the 'Apply' button to make the new value 
effective. 
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Tool Speed: 
 
Job Feedrate: 
 
Job feedrate (G01) is the speed when the tool is engaged into material and working. Bringing your 
arrow on the number that shows Job Feedrate (100%) for each pen and Double clicking on the 
percentage number should open a box that will allow you to change this number. If your job federate 
in tool speed is 2in/sec and you make the red pen to give output at 50% then job should run at 1in/sec. 
 
Move Speed: 
 
Move speed (G00) has one function, it is the speed when the tool is retracted and the machine is 
moving to the next shape after finishing the previous one.  
 
Z feed (down) and Z feed up Speed: 
 
In case of LinkMotion CNC/Engraving software, the default Z Feed (Down) value and Z feed Up can 
be made active simply by setting the speed value in the Materials Properties section. This will allow 
you to bring the Z axis up and down using the Control Pad of LinkMotion. LinkMotion uses Z Feed 
UP speed when simply jogging to bring the Z Axis up or down using the Control Pad. When a job 
is sent to the machine, LinkMotion will make Z axis travel up and down using the different speeds 
declared for Z Feed(Down) and Z Feed Up. (When Z Ref key is pressed it uses higher of the two 
speeds (Z Feed or Z Feed Up) declared. 
 
Z Feed(Down) Speed is setup in each material related settings individually in the  
LinkMotion.INI file with the following lines.  
ZFeed_in=1.0 or ZFeed_cm=2.5 or ZFeed_mm=25.00 
 
Z Feed Up Speed is setup in your selected machine related settings of the LinkMotion.INI file  
with following lines.   
Speed_ZFeedUp_in=1.0 or Speed_ZFeedUp_cm=2.5 or Speed_ZFeedUp_mm=25.00 
 
 
Cutter: 
 
Depth: 
 
Depth is the value declared for tool to travel in the material. Once the top of the material surface is 
determined, depth value controls the movement of the tool in the vertical axis.  
 
Maximum depth per pass for version 4.05 and higher: 
 
The capability of cutting deeper into any material using multiple passes was present in the earlier 
version of the software as described on the following page. However, the process was streamlined, 
speeded up, and simplified. 
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Under Cutter in the Materials Tab, note two boxes, Depth and Max Pass Depth. A check box is 
added to the Max Pass Depth selection as shown in the picture for Material Properties at the beginning 
of this section. When this check box is checked with proper value and user clicks on the Apply button 
you will see the following dialog box. Click on the OK button will process the job with multiple passes. 
Please understand this process by reading this section completely before using it. 
 
 

 
 
 
The selecting or unselecting of the Max Pass Depth box is completely under the user control. Note that 
the value in the Max Pass Depth box is grayed (not active) as long as the box is not checked. The box 
shall be checked when it is necessary to achieve the depth in multiple passes. Logically, a value equal to 
the maximum depth allowed per pass. The Max Pass Depth value need not be an integer multiple of total 
depth desired. For example, the desired total depth is 20 mm. However, the machine and the tool is 
capable of cutting 7 mm per pass of the material. Enter 7 mm for Max Pass Depth. The software will 
show you that it will take two passes of 7 mm each and the last one will be 6 mm. It will take care of 
fractions, too. 
 
The capability of cutting Max Pass Depth is going to be different for different machines based on its 
power and strengths of its motors, the strength of the tools used, and the power of the spindle and its 
motor. Once a value is entered for a specific material for the maximum cutting per pass, it will be saved 
in the INI file. It will be available to the user the next time the same material is used. User can change 
the value anytime and any new value will be saved and will be over written over the previous value of 
maximum pass cutting per pass. 
 
LinkMotion is designed for the tool to not lift up for Z axis between the each pass if it is a close 
shape. However, Z axis will lift up between each pass if it is an open shape. 
 
The job will be processed as follows, 
 
Move the tool to the beginning of the first shape. 
Bring the tool down to the Max Pass Depth. 
Cut the shape to the Max Pass Depth. 
Bring the tool down to the second Max Pass Depth. 
And keep going until the first shape is reached to the total required depth in multiple passes. 
 
Move the tool to the beginning of the second shape. 
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Repeat the process until the second shape is reached to the total required depth in multiple passes. 
 
Repeat the same process for each of the shapes until the job is complete. 
 
We removed the unnecessary movement of the machine to travel back to the job starting position to save 
time. Also, we removed the feature of stopping at the end of every pass before starting the next pass. 
However, the Pausing of the job is available at any time during the job. 
 
Lift: 
 
Lift is the value for tool to lift between the shapes to do the job. If you have several inches of travel 
available for Z axis then it saves time to plug in the lift value where it does not travel all the way up for 
Z axis between the shapes and instead it travels only by the Lift value and saves time. 
 
Dwell: 
 
Dwell (G04) is the amount of time in seconds or fraction of seconds the tool will stay at the same 
position in the material before making X, Y move (so it can build up air pressure prperly if Z axis is 
controlled by Solenoid) for cutting or engraving the shape and after finishing the shape it will stay in the 
material for half of the Dwell time declared before it lifts up. 
 
 
Per-Pen/Color Settings: 
 
Solustan provides a color palette for the 10 colors used in LinkMotion. This can be 10 colors for 
RGB or 7 colors for CMYK color palette. Follow instructions from LM&Corel.PDF document to 
install this color palette file for Corel application users.  User should check their own design 
application if they support windows supported RGB or CMYK colors and test it. While preparing 
jobs, it is important to select proper color schemes to generate expected speed for the Cut/Engarve job. 
We suggest for you to run a trial job before going for the final production. 
 
For each of the colors, you can set the Spindle Speed as a percentage of maximum Spindle Speed 
declared in the LinkMotion INI file. Double click on the Feedrate percentage number for the 
appropriate color. A dialog box will pop up. Select and change the number. Range for speed should be 
1 to 100 in percentage value. Refer to the full description for spindle speed control in LinkMotion 
Control Pad description chapter. 
 
For each of the colors, you can set the Job Feedrate as a percentage of maximum Job Feedrate speed 
declared on the left side under the Tool Speed. Double click on the Feedrate percentage number for 
the appropriate color. A dialog box will pop up. Select and change the number. Range for speed should 
be 1 to 100 in percentage value. 
 
Jobs can be designed in color and spindle speed and job feed rate can be defined as percentage of 
declared values for each of the colors. One of the applications of this feature is to design the same job in 
different colors on different layers and sequence the layers appropriately. 
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Following are the color/pen values for the LinkMotion V 3.0 and higher printer driver. RGB values are 
given in percent. 
 
Following are the RGB (Works well with all operating system and Corel X3, X4, X7) and CMYK (Not 
as reliable with Win 8, 10 and Corel X7) color/pen values for the LinkMotion V 3.5 and higher: 
 
Pen no.  Color R G B -- C M Y K 
 
          1  Black  0 0 0  -- 0 0 0 100 
          2  Red  255 0 0 -- 0 100 100 0 
          3  Green  0 255 0 -- 100 0 100 0 
          4  Blue  0 0 255 -- 100 100 0 0 
          5  Cyan  0 255 255 -- 100 0 0 0 
          6  Magenta 255 0 255 -- 0 100 0 0 
          7  Yellow  255 255 0 -- 0 0 100 0 
          8  Orange  255 128 0 -- Not Available 
          9  Brown  255 192 0 -- Not Available 
         10  Purple  128 0 255 -- Not Available 
  
It is advisable to set up a color palette with the above 10 colors with respective RGB values or 7 colors 
with respective CMYK colors. Use this newly defined palette to design your jobs where color is 
required. Solustan provides LinkMotion RGB.cpl  and LinkMotion CMYK.cpl file with the software 
that can be loaded in Corel Draw. LM&Corel.pdf document has the instructions for loading that 
properly in Corel. Updates files are also available for download on Solustan’s support section of our 
web site. 
 
If you do not create a color palette with the above RGB or CMYK values, the GDI may not 
convert proper color settings file. This process may result in errors.  
 
 
Spindle Speed% 
 
For each of the colors, you can set the Spindle Speed as a percentage of maximum Spindle Speed 
declared in the LinkMotion INI file. Double click on the Feedrate percentage number for the 
appropriate color. A dialog box will pop up. Select and change the number. Range for speed should be 
1 to 100 in percentage value. Default Spindle speed in RPM is declared in the GENERAL section of 
the LinkMotion.INI file as SPINDLE_RPM=1000 as shown below. User can change this value per 
your spindle manfacturor’s specifications. Percentage of this value is used in generating the Gcode 
file for different color shapes with different ‘S’ value. Example-S1000 at 100% and S500 at 50%. 
User requires to save this change in the value and Re-launch Linkmotion for it to be effective. 
 
[GENERAL] 
SPINDLE_RPM=1000  
 
Once these values are set for your machine and your spindle, you can vary them using color for the 
vector lines in your design. Please, note that the Material Tab now shows two different settings per 
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color. These are, feed rate and spindle speed. Both are percentage of the declared speeds. Also, these 
values can vary from material to material. You can save lots of information and use it again and again. 
Solustan provides readymade RGB color palettes for the 10 colors and CYMK for 7 colors CMYK (Not 
as reliable with Win 8, 10 and Corel X7) that are used for the user's convenience. Refer to the color 
chart below in the Job Feedrate section. There will be one to one correspondence between your selection 
for the color and proper feed rate and spindle speeds will be maintained for the jobs. 
 
What is a simple example of using these techniques? 
Let us say that after marking a few shapes on the material, it is required to cut out the material. 
Select one color for the shapes and select appropriate feed rate and spindle speed percentages.  
Draw the out side shape that is required to cut the materials through in a different color. Make sure it is 
the last in the sequence of shapes sent out by Corel Draw. 
Change the feed rate to slower number and increase the spindle speed for the second color. 
 
Job Feedrate% 
 
For each of the colors, you can set the Job Feedrate as a percentage of maximum Job Feedrate speed 
declared on the left side under the Tool Speed. Double click on the Feedrate percentage number for 
the appropriate color. A dialog box will pop up. Select and change the number. Range for speed should 
be 1 to 100 in percentage value. 
 
Jobs can be designed in color and spindle speed and job feed rate can be defined as percentage of 
declared values for each of the colors. One of the applications of this feature is to design the same job in 
different colors on different layers and sequence the layers appropriately. 
 
Following are the color/pen values for the LinkMotion V 3.0 and higher printer driver. RGB values are 
given in percent. 
 
Following are the RGB (Works well with all operating system and Corel X3, X4, X7) and CMYK (Not 
as reliable with Win 8, 10 and Corel X7) color/pen values for the LinkMotion V 3.5 and higher: 
 
Pen no  Color  R G B -- C M Y K 
 
         1  Black  0 0 0  -- 0 0 0 100 
         2  Red  255 0 0 -- 0 100 100 0 
         3  Green  0 255 0 -- 100 0 100 0 
         4  Blue  0 0 255 -- 100 100 0 0 
         5  Cyan  0 255 255 -- 100 0 0 0 
         6  Magenta 255 0 255 -- 0 100 0 0 
         7  Yellow  255 255 0 -- 0 0 100 0 
         8  Orange  255 128 0 -- Not Available 
         9  Brown  255 192 0 -- Not Available 
        10 Purple  128 0 255 -- Not Available 
         
It is advisable to set up a color palette with the above 10 colors with respective RGB values or 7 colors 
with respective CMYK colors. Use this newly defined palette to design your jobs where color is 

34



required. Solustan provides LinkMotion RGB.cpl  and LinkMotion CMYK.cpl file with the software 
that can be loaded in Corel Draw. LM&Corel.pdf document has the instructions for loading that 
properly in Corel. Updates files are also available for download on Solustan’s support section of our 
web site. 
 
If you do not create a color palette with the above RGB or CMYK values, the GDI may not 
convert proper color settings file. This process may result in errors.  
 
Cad design applications may not be supporting this function. Please test before using it. 
 
 
Design using material Size: (Fully tested with Corel Draw design application only) 
 
Before you try to understand and activate Design Using Material Size, we suggest that you read the 
section on Machine Properties (a little later in this document). 
 
Please, understand the two concepts clearly: 

- Set the page size in the job design software to be the same as the working area of the machine 
declared in the Machine Properties. 

- Set the page size in the job design software (fully tested with Corel Draw design application so 
far) to be the same as the material size for the job. In both cases, the working area of the machine 
declaration in the Machine Properties remains the same. The machine size is not changing. 

 
Why set the material size? What are the advantages? 
 
Different strokes for different folks. Many users interested in engraving award type plates may want to 
center the job, select different size and type fonts for different lines, change and recompose jobs with 
ease, be able to see the design in a larger area of the screen, and take advantage of many composition 
features the design software has to offer. 
 
Setup: 
 
Check and understand three areas for setup before using this function.  
(1) LinkMotion applet setup, (2) LinkMotion printer driver setup and (3) Design application setup. 
 
1. LinkMotion Applet Setup: 
 
It is extremely important to first setup your machine with all the settings in each section (tab) of 
LinkMotion, Refer to detail explanation for Machine properties, Motor parameters and Origin Setup, Do 
some preliminary testing with full page size design (same as what you declare in the X and Y maximum 
travel in machine properties and then move to test this function).  
 
2. LinkMotion Printer Driver Setup in the job design software: 
 
It is also important to select proper orientation (Portrait or Landscape) under printer setup 
depending upon your table size declared in Machine setup to get the output in correct location.  
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Setting up the printer properties for Win XP, Win 7 32 and 64 in the operating system: 
Go to Devices and Printers (Printers and Faxes under Win XP) from Start button. Right Click on 
this printer with your machine name and select “Printer properties”. Click on Advance button. Click 
on Printing Defaults button. Here choose your table orientation. If X maximum travel is larger then Y 
maximum travel, choose Landscape. If X maximum travel is smaller then Y maximum travel, choose 
Portrait. Click on the OK button. Click on the OK button of the Printer properties. 
 
3. Job Design Application Setup: 
 
There are a number of ways to set up a job in your design program in order to process it in the right 
location on the working area of the machine. 
 

(1) Test with same page size as Machine’s table size: Initial testing should be always done with 
page size to be the same as your machine’s table size. Declare the working area of the machine 
in the Machine Properties Tab of the LinkCAM. If you changed the values, relaunch the 
LinkCAM applet. Re-start the job design program for it to accept the new working area of the 
machine. The job design program receives this information from the LinkCAM driver at the time 
it launches. Set the page size in the job design program to be the same as working area of your 
machine. Prepare the job in the new page where you want it to appear on the machine. 

 
(2) Test with same page size as Machine’s table size declared to be smaller then actual table 

size: If the user is setting up a jig with a lot different and smaller size than the total working area 
of the machine, it may be advantageous to change the working area of the machine in LinkCAM 
and design the job using the smaller page size. It is possible to set the starting location of the 
tool, X and Y axis tool offsets from the starting position if necessary and required, and the 
selection of the starting position (see more explanation later). 

 
(3) Test with Design using material size: If you are using program like Corel Draw to work with 

material size by way of using the plate size concept to position the job properly, you can design 
in the plate area while keeping the machine (table) size as is. Procedure for Design using 
material size will give you step by step instruction below. 

 
Job design using material size (plate size): LinkMotion.INI file controls this function. Following line 
should be present in the area within the section with your machine configuration: 
UseMaterialSize=1 or 0 
 
Default value is 1 and the Design using material size will show up in Materials properties tab. 0 will 
hide this interface from the Materials menu and output will be in relation to the table size declared. The 
picture of Materials Properties page shown earlier in this document displays Material Size user interface. 
 
Once you have setup the machine properly and simple output is correct in size and correct 
location you do not need to change any of the settings for Design using material size function. 
 
Procedure for Design using material Size: 
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Check the box for Design using material size in material properties.  
Click on the Apply button.  
Enter the values for material (plate) width and height.  
Click OK. (LinkMotion applet will close) 
When Plate Design is active user can choose any plate size smaller then actual table size.  
(Table size is declared in Machine setup of LinkCAM under Maximum travel for X and Y axis.)  
Launch your design application.  
Create your page size in Corel DRAW same as your material size declared in LinkMotion. 
 
Your plate design can be portrait or landscape and as long as orientation selection is correct in printer 
setup the output will be in correct location. Please do some sample testing before doing final production 
with your design application.  
 
If you have selected orientation mode to be Landscape and your plate size has portrait mode you should 
see following message: 
“Paper Orientation does not match one or more document pages. Adjust Printer automatically?” 
Click on the Yes button if you are using on Windows 7 and output should be in correct location. 
Click on the No button if you are using on Windows XP and output should be in correct location. 
 
Similarly, if you have selected orientation mode to be Portrait and your plate size has landscape mode 
you should see following message: 
“Paper Orientation does not match one or more document pages. Adjust Printer automatically?” 
Click on the Yes button if you are using on Windows 7 and output should be in correct location. 
Click on the No button if you are using on Windows XP and output should be in correct location. 
 
When you want to change the plate size.  
Go to Material properties of LinkMotion and change the width and height. 
Click on the Apply button. 
Click OK. (LinkMotion applet will close) 
 
Important Warnings: 
This function was tested to work with Corel Draw only. We have not tested the Plate Size function 
with different applications. Print preview from your design applications like Corel Draw will not 
display proper job output location when you preview it for Material Size but output will be in 
proper location on your machine. 
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Machine Properties: 
 
 

 
 
 
Enable output 1, 2, 3 and Spindle/Air: 
 
If Enable I/O control 1 is checked, it will turn the I/O 1 ON while cutting/engraving a shape during a 
job and turn itself OFF at the end of completing the shape. The I/O will stay OFF during the 
traverse/Move motion to the beginning of the next shape. 
  
If Enable I/O control 2 is checked, it will turn the I/O 2 ON while cutting/engraving a shape during a 
job and turn itself OFF at the end of completing the shape. The I/O will stay OFF during the 
traverse/Move motion to the beginning of the next shape. 
 
Z axis can be set up as motorized or solenoid (I/O) controlled. If it is solenoid controlled, It can be 
attached to I/O 1 or I/O 2. 
 

38



If Enable I/O control 3 is checked, it will turn on and off with the job execution. It will not turn off 
between the shapes. 
 
If Enable I/O control 4 (Spindle) is checked, it will turn on and off with the job execution. The value 
of delay can be entered in seconds and fraction of seconds in the Spindle Delay area. It will issue a 
spindle ON command and then, will issue a G04 dwell command or the delay. This delay value will 
allow the spindle motor to reach its speed before the tool plunges into the material. 
 
G-Code can be generated for I/O4 for Spindle on/off command with two options. Two options are 
controlled using a line in the LinkMotion.INI file under your selected machine related settings.  
GCodeFileOutput=0 or 1 
Value 0 (zero) generates M64 P4 and M65 P4 commands for spindle to turn on at the beginning of 
a job and turn off at the end of the job.  
Value 1 generates M03 and M05 commands for spindle to turn on at the beginning of a job and 
turn off at the end of the job. 
Remember to Save the Linkmotion.INI file and Re-launch LinkMotion for this change to be 
effective. 
 
Output settings 
 
I/O’s    Control logic High Control logic Low    
 
I/O 1  M64 P1  M65 P1 
 
I/O 2  M64 P2  M65 P2 
 
I/O 3  M64 P3  M65 P3 (alternate controls for the same output) 
 
I/O 4  M03   M05  or  

M64 P4  M65 P4 
 
Please refer to the material properties section for using Spindle speed in % with different colors. 
 
 
Machine Travel (Table size) for X and Y and Maximum Z travel: 
 
Setting the Maximum Travel allowed in each of the axes is an important part of the Machine Properties 
tab. As discussed earlier, the page size in the job design software (Corel Draw, AutoCAD, etc.) can be 
set to either the working area of the machine or the size of the material used for the job. 
 
Minimum of 0.3937x0.3937  inch or 1x1 cm and maximum of 192”x192” or 487.64x487.64 cm for 
X and Y axis for Table size.  
 
Version 4.78 and higher does not require for user to follow DPIScale and DPIIndex setting in the 
LinkMotion.INI file. It is controlled by simply changing the value in the LinkMotion.INI file 
under your selected machine name with the following line.  

39



DPIResolution=1000(default number) User can change this number to 500, 600, 750 or 800 if 
needed. This change in the INI file requires for user to save and re-launch LinkMotion for it to be 
effective. 
 
Version 4.77 and lower you need to refer to the resolution number chart for maximum available 
output size for the table size as described in the DPI Resolution information in next few pages. 
Do not design jobs outside of that page area. 
 
The maximum travel distances of the machine (working area) in X, Y and Z axis is set here. The 
maximum travel numbers should match the page size in the design applications you are using (for 
example, Corel Draw or AutoCAD.) If the numbers do not match, the job will  not appear in the 
intended location on the machine. Setting these numbers correctly allows precise positioning of the job 
on the machine. 
 
The following four settings are necessary for the proper positioning of the job on the machine: 

1. Maximum travel area in the Machine Properties of LinkMotion/LinkCAM 
2. Matching page size in the job design application program 
3. Starting position with necessary offsets 
4. Physical positioning of the tool on the machine to match the declared starting position with 

offsets 
 
If you are using Corel Draw to design the job with the page size set to the material size (instead of the 
machine size,) please refer to the section – Design using material size in the Materials Properties section. 
 
Output Quality and Maximum Table size with DPI Control (required only for V4.77 
and lower): 
 
Following line is located in the LinkMotion.INI file withing your selected machine setup area. User 
needs to Re-launch LinkMotion after making any changes as explaind in following lines: 
DPIScale=100 (Maximum value 100 is for 1000 DPI. Change this to 60 will give you 600DPI.) 
DPIIndex=10 (This value is from 6 to 10 respectively and design program will remember this for 
your job. It is importanat to change this with correct number associated with it.) 
 
DPIScale=50 (Value gives output with 500 DPI),  DPIIndex=6 (Value for 500 DPI) 
DPIScale=60 (Value gives output with 600 DPI),  DPIIndex=7 (Value for 600 DPI) 
DPIScale=75 (Value gives output with 750 DPI),  DPIIndex=8 (Value for 750 DPI) 
DPIScale=80 (Value gives output with 800 DPI),  DPIIndex=9 (Value for 800 DPI) 
DPIScale=100 (Value gives output with 1000 DPI),  DPIIndex=10 (Value for 1000 DPI) 
 
DPI Guidelines for high quality output and Mamximum available table size 
(required only for V4.77 and lower): 
 
Example below gives maximum X and Y axis numbers . User can change X and Y in any combination 
as long as it does not exceed the mutipication number then it will work. Design applications you use 
may have their own limitations. Please check with the manufacturer of your design application for 
proper use of followin settings.  
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Example: Corel draw works well but Adobe Illustrator works at 1000DPI in default mode so Illustrator 
users can work with maximum table size of 65” x 65” or 84” x 50” or 96” x 44” so it does not exceed 
multiplication 4225 number. 
 
500 DPI – Maximum table size 129”x129” = 16,641 Do not exceed this multiplication number. 
600 DPI – Maximum table size 109”x109” = 11,881 Do not exceed this multiplication number. 
750 DPI – Maximum table size 87”x87” = 7,569 Do not exceed this multiplication number. 
800 DPI – Maximum table size 81”x81” = 6,561 Do not exceed this multiplication number. 
1000 DPI – Maximum table size 65”x65” = 4,225 Do not exceed this multiplication number. 
 
Example: If your machine has Table size of 96”x48” then set DPIScale=80 and DPIIndex=9 for 
getting the best possible output quality.  
 
Following guidelines are created using Corel X4 and Win7 64 bit computer. It may vary for other 
design applications and older operating system. 
 
Resolution DPI  50 100 200 300 500 600 750 800 1000 
Line Weight 
0.001” - 0.0254mm  Vect Vect Vect Vect Vect Vect Vect Vect Vect 
0.002” - 0.0508mm  Vect Vect Vect Vect Vect Vect Vect Vect Vect 
0.003” - 0.0762mm  Vect Vect Vect Vect Vect Vect Vect Vect Vect 
 
LinkMotion generated Warning message for job not designed for vector output: 
 
LinkMotion will display following message when a “Print” command is used from your design 
application but LinkMotion did not find any shapes for generating that job for cutting/engraving output. 
 
 

 
 
 
Please look at your job and make correction for no fill and hairline or thinnest line shapes for output of 
graphics as well as all text. Now when you print the job it should output properly with properly 
generated gcode file. 
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Origin Setup:  
 

 
 
 
Return to 0, 0 after job: 
 
Return to 0,0, after job – If the box is not checked the tool will retract on Z axis and stop at the 
position where it finished the last shape at the end of the job. It will not return to the start position. 
However, if the box is checked, the tool will go back to the starting position (parking position) for X, 
Y and Z axis at the end of the job. Most of the time parking positions are 0, 0 for X and Y. Make sure 
you have proper value declared for Z axis considering the material surface and how much the tool can 
travel going back up after touching the surface of the material. 
 
Offset Polarities and Directions: 
 
Offset polarities and direction diagram is shown to display how Machine’s travel for X and Y axis 
works using LinkMotion software. It also displays positive or negative values respectively. 
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Positive and Negative Direction Explanation: 
(1) If your tool is parked on the top left area of your machine then X axis travel to the right is 

positive values and Y axis travel towards front has negative values.  
(2) If your tool is parked on the bottom left area of your machine then X axis travel to the right is 

positive values and Y axis travel towards the back has positive values. 
(3) If your tool is parked on the top right area of your machine then X axis travel to the left is 

negative values and Y axis travel towards front has negative values.  
(4) If your tool is parked on the bottom right area of your machine then X axis travel to the left is 

negative values and Y axis travel towards back has positive values.  
 
General Z down travel is negative and Z up treavel is positive values. Z axis values are calculated after Z 
axis is surfaced on the material which is zero position. 
 
Start Position: 
 
Bottom Center, Bottom Left, Bottom Right, Center, Top Center, Top Left and Top Right are the 
choices. 
 
Start Position offsets are entered for each axis with proper understanding. Picture in Origin Setup 
tab shows how you can enter positive or negative values for the offsets. It is the distance between the 
tool’s resting position and the job’s starting position. If both the positions are the same, the offset values 
are zero. 
 
Following diagram also explains how the values are declared for X and Y axis offsets. We have shown 
examples for Top Left and Bottom Left start positions. User can understand this and then enter proper 
values per your selection of the start position. 
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The Z offset or Safe Z for generating proper G-Code files. 
 
LinkMotion.INI file has a line SafeZ=0 or 1. Default value is always 1(one).  
 
When SafeZ is set to be 1, user needs to make sure of the following: 

1. Declare the SafeZ value in the start position offset of Z axis (LinkMotion’s origin setup tab) in 
inches or mm. 

2. This will declare SafeZ value for the first and the last Z axis moves during the generating a G-
Code file for a job. 

3. Bring the tool down to where it touches the top surface of the material to be worked on before 
sending the job to the CNC controller. 

4. LinkCAM will move the Z axis and the tool up by the value declared in the SafeZ offset before 
making any other moves in processing the job. It will also move up at the end by the same value. 

 
When SafeZ is set to be 0, user needs to make sure of the following: 

1. Declare the SafeZ value to be zero in the start position offsets of Z axis (LinkMotion’s origin 
setup tab). 

2. This will declare SafeZ value to be zero for the first and the last Z axis moves during the 
processing of a job. 

3. Open and edit the G code file and insert Z up command (positive value) at the beginning of the 
file to move the tool to a SafeZ value and similar Z up command (positive value) at the end of 
the file to move the tool up after it finishes the job and save it. 

4. Bring the tool down to where it touches the top surface of the material to be worked on before 
sending the job to the CNC controller. 

5. It will move Z up by declared value in your G-Code file for the first and the last move. 
 
Example File 1 is generated without activating Safe Z in Linkmotion or SafeZ=0 value in 
Linkmotion.INI file: 
G94 
G90 
G20 
G64 P0.004 
G01 Z0.000 F30.000 
G00 X1.000 Y-1.000 F30.000 
G01 Z-1.000 
G04 P0.100 
G01 X5.000 Y-1.000 F60.000 
X5.000 Y-3.000  
X1.000 Y-3.000  
X1.000 Y-1.000  
G01 Z-0.600 F30.000 
G00 X3.500 Y-4.000 F30.000 
G01 Z-1.000 
G04 P0.100 
G01 X6.500 Y-4.000 F60.000 
X6.500 Y-6.000  
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X3.500 Y-6.000  
X3.500 Y-4.000  
G01 Z0.000 F30.000 
G00 X0.000 Y0.000 F30.000 
M02 
 
Example File 2 is generated with Safe Z activated in Linkmotion or SafeZ=1 value in 
Linkmotion.INI file: 
G94 
G90 
G20 
G64 P0.004 
G01 Z0.850 F30.000 
G00 X1.000 Y-1.000 F30.000 
G01 Z-0.15 
G04 P0.100 
G01 X5.000 Y-1.000 F60.000 
X5.000 Y-3.000  
X1.000 Y-3.000  
X1.000 Y-1.000  
G01 Z0.25 F30.000 
G00 X3.500 Y-4.000 F30.000 
G01 Z-0.150 
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Motion Control Boards for Design and Insert Specific Commands: 
 
 

 
 
 
Specific commands unique to a specific machine can be inserted at the above locations. Many times 
these are M codes or other commands to activate spindle, vacuum, lubrication, and other functions. 
Also, you can insert subroutines like drilling (G81, G82, G83, G85, G89), temporary coordinates (G53 
through G59, and other commands. Commands specific to your machine can be entered and generated 
using the above shown buttons. 
 
Initial or Setup commands: 
 
Click Board setup button and enter commands in one or many lines just the way you want. Once you 
save the commands, it will be sent every time a job is sent. This will be the very first part of a G code 
file. 

 
Start Job: 
 

47



Click the Start Job button and enter commands on one or more lines exactly as you want them to appear 
in the G code. Once you save the commands, they will be sent every time a job is sent, right after the 
Board Setup commands in the G code file. We use to declare in inches as G64 P0.004 in older version. 
Now Deafult setup is G64 P0.1 Q15 here.  
 
P value is for Adherence to original vector and it allows maximum deviation from the original 
vector in mm. P value should be always declared in mm and design path should not deviate more 
then the value declared here for your output. This P parameter is part of the G code command 
structure. What it means is that the G code interpreter can only deviate from the original design lines by 
no more than 0.1 mm. If you allow more deviation from the original design, the machine is likely to run 
faster but may have less than desirable results (Design path is less accurate). User can try making it 1 or 
2 mm and then process a small rectangle. You will notice that the corners are rounded instead of sharp 
90 degree corners. 
High speed with low acceration value declared should display clear deviation for a rectangle shape using 
P value to be 0.1mm and 10.0mm value. 
 
Q value is the change in the angle (in degrees) for a path of your design for two successive vectors. 
Machine will slow down when detected angle of the design path is 15 degrees or less. We do have a 
solution to look ahead on the next vector using Q command and as long as the angle of change is not 
sharp, we can continue to move without slowing down. This is our newest implementation and we have 
not checked it fully. The user can actually declare a value of the angle. For a heavier gantry, you may 
call out for an angle as small as 15 to 25 degrees for the gantry to decelerate and accelerate to prevent 
overshooting. For lighter gantries, the angle could be as liberal as 40 degrees or more. This Q value can 
be different for your needs. 
 
Similarly Spinlde speed can be declared here by using M3 S18000 value (This is just an example 
value). User needs to know proper selection of their spindle speed from their spindle 
manufacturer. Explanation is available in Material properties section for using different Spindle 
speed in percentage with different RGB and CYMK colors. 

 
Start Shape 

 Click Start Shape button and enter commands in one or many lines just the way you want. Once you 
save the commands, it will be sent every time a job is sent. A job can be made up of many different 
shapes. These commands will be repeated at the beginning of every new shape in the G code file. 
 

End Shape 
Click End Shape button and enter commands in one or many lines just the way you want. Once you 
save the commands, it will be sent every time a job is sent. A job can be made up of many different 
shapes. These commands will be repeated at the end of every new shape in the G code file. 
 

End of Job 
Click End Job button and enter commands in one or many lines just the way you want. Once you 
save the commands, it will be sent every time a job is sent. This will be the positioned right at the 
end of the job in the G code file. 
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Pen/Color Change 
Click Pen/Color Change button and enter commands in one or many lines just the way you want. 
Once you save the commands, it will be sent every time a job is sent. These commands will be 
repeated every time that is a change of color in the job. 

 
How to enter and edit unique commands:  
 
 

 
 
 
There are four simple edit controls. 
 
Click on the dotted box and you create a new line at the bottom of the list in the box. You are ready to 
enter your unique and specific commands. 
 
The red X selection will delete the highlighted line from the list. 
 
The Up arrow will move the selected line above the previous line. 
 
The Down arrow will move the selected line below the next line. 
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G Code Files: 
 
 

 
 
 
This allows you to output previously generated G-Code and 3D G-Code files of other applications to 
your machine from LinkMotionUSB driver. If you send 3D G-Code files make sure that your machine is 
capable of handling 3D files. User needs to make sure that you have setup all the parameters for 
your machine properly by going to the Machine Properties, Material Properties, Origin setup and 
Motion Control Boards before sending the file from here. 
LinkMotion software in demo mode may have limitations. 
 
User simply can click on the G Code Files menu and it will show you the dialog box to select your file 
from where it is on your computer. You simply navigate to the file and click on the Open button and it 
should output on your machine. 
 
LinkMotion USB uses EMC2 interpreter with following Supported M and G codes: 
 
User can download the manual from www.linuxcnc.org/docs/EMC2_User_Manual.pdf. This has 

50



complete explanation for M and G-Codes. 
 
G0  Rapid linear motion – program X-Y-Z-A-B-C- all 6axis motion commands 
G1  Linear motion at feed rate 
G2  Arc at feed rate clockwise 
G3 Arc at feed rate counterclockwise 
G4  Dwell 
G10 Select Coordinate Offset System 
G17, G18, G19 Select Plane 
G20 for inch, G21 for mm works with LinkMotion. Some G-Code generating programs use G70, G71  
and user should replace these with G20 for inches and G21 for mm. 
G40, G41, G42 Cutter Compensation (requires pre-defined tool table file) 
G43, G49 Tool Length Offsets (requires pre-defined tool table file) 
G53 Position Move without regard to current Coordinate Offset 
G54, G55, G56, G57, G58, G59, G59.1, G59.2, G59.3 Set Coordinate Offset (requires coordinate 
parameter file) 
G61, G61.1, G64 Set Path Control Mode (Control radius at corners like P0.004) It is important to have 
P in front of the value. 
G80 Cancel Modal Motion 
G81-Drilling, G82-Drilling with Dwell, G83-Peck Drilling / Canned Cycles 
G90-Absolute mode, G91-Increemental mode 
G92, G92.1, G92.3 Coordinate System Offsets 
G93, G94 Set Feed Rate Mode – G94 to start units per minute mode. G93 to start inverse time mode. 
G98, G99 Canned Cycle Return Level 
M1 – Stop running program temporarily (not sure) M2 or M30 to end the Program. 
M3-Spindle start Clockwise, M4-Spindle start Anticlockwise,  
M5-Stop Spindle / Spindle Control (Do not include S commands for spindle speed) 
M7 and M8-Coolant on, M9-Coolant Off  / Coolant Control 
M6 – Tool Change command – T(X) 
M62 Turn on digital Output synched with motion, M63 Turn off digital output synched with motion 
M64 Turn on digital output immediately, M65 Turn off digital output immediately. 
 
If your software generates F commands for feed rate it should always have proper number values 
like F2.0 for job feed rate. If you have 0.00 value or no value after F it will not process your file. 
You also need to have end of the file command with either M02 or M30. Files will not be processed 
if end of the file command is missing. 
 
The process requirement using M & G codes will be as follows: 
 

1. User will set the tool at X=0, Y=0, and Z=0. Typically, the user may bring the tool to lower left 
of the machine and bring the tool down to where it touches the top of the surface. Also, the 
material may also be set to the lower left of the machine. 

2. If there is a jig set up, the user may bring the tool to one of the corners of the material and bring 
the tool to the top surface of the material. This will be 0, 0, 0. 

3. The CAM program shall have the facility to declare a very first move command to be a tool lift 
distance defined by the user. 

51



4. The processing will start at this point. Including spindle on, turning on of the I/O’s, G rapids, and 
the rest of the job. 

5. If the CAM program does not have the facility to lift the Z axis at the beginning of the job, the 
user will be required to edit the file and insert appropriate tool lift command. 

6. Assuming X axis to be the axis from left to right as the user faces the machine, X axis moving 
right is a positive number and X axis moving left is a negative number. 

7. Assuming Y axis to be the axis from front to back as the user faces the machine, Y axis moving 
away from the user is a positive number and Y axis moving toward the user is a negative 
number. 

8. For the Z axis, Z axis moving up is a positive number and Z axis moving down is a negative 
number. 

 
How to use G54 to G59.3 commands for Set coordinate offset: 
 
A. If working with inches and if you use G10 L2 command, you need to program the offset values in 
user units. If your user units are in mm, you need to declare offsets in mm. Similarly, if your user units 
are in inches, you need to declare the offsets here in inches. 
 
B. However, if you are working with 52XX parameter commands to set your offsets, these parameters 
shall always be declared in mm, no matter what the user units are. 
 
C. It is always a good idea to set G54 to coincide with machine home in order to bring it back to 
machine home at the end of a job. At this point, we restart G-code compiler at the end of every job. 
Whatever the offset settings were, were reset. We may choose to change that in future. It will be a good 
practice to set G54 for machine home and bring it back. This will allow you to operate your saved jobs 
in future, even if we make changes to the compiler in future. Please, note the additional command G00 
X0 Y0 Z0 after issuing G54 to bring the machine back. See following examples. 
 
Example 1 - Using G10 L2 P1 command: 
 
G94 
G90 
G20 
G10 L2 P1 X0.0 Y0.0 Z0.0 
G10 L2 P2 X2.0 Y-2.0 Z0.0 
G10 L2 P3 X4 Y-4 Z0 
G64 P0.004 
G55 
G00 X0.005 Y-0.011 F60.000 
G01 Z-1.272 
G04 P0.100 
G01 X1.186 Y-0.011  
X1.186 Y-0.601  
X0.005 Y-0.601  
X0.005 Y-0.011  
G01 Z-1.119 
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G00 X0.202 Y-0.798 F60.000 
G01 Z-1.272 
G04 P0.100 
G01 X1.383 Y-0.798  
X1.383 Y-1.389  
X0.202 Y-1.389  
X0.202 Y-0.798  
G01 Z0.000 
G00 X0.000 Y0.000 F60.000 
G56 
G00 X0.005 Y-0.011 F60.000 
G01 Z-1.272 
G04 P0.100 
G01 X1.186 Y-0.011  
X1.186 Y-0.601  
X0.005 Y-0.601  
X0.005 Y-0.011  
G01 Z-1.119 
G00 X0.202 Y-0.798 F60.000 
G01 Z-1.272 
G04 P0.100 
G01 X1.383 Y-0.798  
X1.383 Y-1.389  
X0.202 Y-1.389  
X0.202 Y-0.798  
G01 Z0.000 
G00 X0.000 Y0.000 F60.000 
G54 
G00 X0 Y0 
M02 
 
Example 2 - Using G54 to G59.3: 
 
G94 
G90 
G20 
#5221=0 
#5222=0 
#5241=50 
#5242=-50 
#5261=100 
#5262=-100 
G64 P0.004 
G55 
G00 X0.005 Y-0.011 F60.000 
G01 Z-1.272 
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G04 P0.100 
G01 X1.186 Y-0.011  
X1.186 Y-0.601  
X0.005 Y-0.601  
X0.005 Y-0.011  
G01 Z-1.119 
G00 X0.202 Y-0.798 F60.000 
G01 Z-1.272 
G04 P0.100 
G01 X1.383 Y-0.798  
X1.383 Y-1.389  
X0.202 Y-1.389  
X0.202 Y-0.798  
G01 Z0.000 
G00 X0.000 Y0.000 F60.000 
G56 
G00 X0.005 Y-0.011 F60.000 
G01 Z-1.272 
G04 P0.100 
G01 X1.186 Y-0.011  
X1.186 Y-0.601  
X0.005 Y-0.601  
X0.005 Y-0.011  
G01 Z-1.119 
G00 X0.202 Y-0.798 F60.000 
G01 Z-1.272 
G04 P0.100 
G01 X1.383 Y-0.798  
X1.383 Y-1.389  
X0.202 Y-1.389  
X0.202 Y-0.798  
G01 Z0.000 
G00 X0.000 Y0.000 F60.000 
G54 
G00 X0 Y0 
M02 
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General Options: 
 
 

 
 

 
Units: 
 
There are just a few things in the General Options screen. Units gives you the choice to display 
measurements in inches, millimeters, or centimeters. If you have switched from one unit to another you 
need to check the settings in all the tabs of LinkMotion to make sure that the settings are correct for your 
machine and correct for your job. The Linkmotion.INI file keeps separate settings for inches and metric 
values. The values are not necessarily coverted directly from one to the other. 
 
Enable Drill support: 
 
Enable Drill support is designed to drill holes. This can be used for creating Braille signs. Selecting 
this option makes your tool travel to the begin point of each shape and go down to create a mark or a 
hole and go back up and go to the begin point of the next shape. 
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For typical CAD programs capable of rendering point entity on the design screen, there is no need to 
enable drill support. 
 
For typical graphic programs not capable of rendering point entity, a shape such as a small rectangle can 
be designed for each of the point entity. When drill support is enabled, the begin point of each shape is 
be retained for generating G codes and used as the drilling point. 
 
INI File Settings: 
 
Following buttons are available for saving and loading different INI files but we highly suggest for you 
to write down your setting numbers from each of the menu(tab) of Linkmotion if newly released version 
of LinkMotion is loaded. This is most suitable to take advantage of new features added in the new 
version of Linkmotion.INI file. 
 
Save: 
 
Once the machine is properly configured and working well, we advise you to save a copy of your 
settings on the hard disk drive. This file will serve as a backup for the LinkMotion.INI that is 
automatically saved by LinkMotion. 
 
Click on the Save button and you will be asked to choose a file name and location. Make sure to 
remember the file name and where you are saving it. You can navigate to the directory where you want 
to save your file. You can name the file anything that will be easy for you to remember. Most of our 
customers rename their settings file with their machine name. 
 
Load: 
 
If LinkMotion needs to be reinstalled, or if you load an upgraded version of LinkMotion, you can reload 
all you INI file settings without wasting time reentering settings for each tab. To reload the settings 
select the Load button and navigate to your saved INI file and click on Apply and OK. Now exit 
LinkMotion by clicking with the right mouse button on the LinkMotion icon in the System Tray and exit 
the program. Go to the Start button and relaunch LinkMotion. You will now see all your saved settings. 
 
Restore Defaults: 
Clicking on this button will load default LinkMotion.INI file that we supply with the LinkMotion 
driver.  
 
You must relaunch LinkMotion when you change and save or select another INI file 
to make the changes effective. 
 
LinkMotion.INI File: LinkMotion keeps a copy of all your settings in a file named LinkMotion.INI. To 
find this file please check the following instructions for your operating system.  
 
Windows 10, 8, 7 32/64:  C:\ ProgramData > Solustan > LinkMotion > LinkMotion.INI 
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Select Computer from the Start button. Select the C: hard drive from the left side. Double click on the 
folder name ProgramData. Double click on the folder name Solustan. Double click on the folder name 
LinkMotion. You should see a file name LinkMotion.INI here. 
 
Windows XP:  C:\ Document and Settings > All Users > Solustan > LinkMotion > LinkMotion.INI 
Select the C: hard drive and double click the folder named Document and Settings. Double click on the 
folder name All Users. Double click on the folder name Solustan. Double click on the folder name 
LinkMotion. You should see a file name LinkMotion.INI here. 
 
 
G Code File Settings: 
 
Saved file path: 
 
Saved file path shows the location where you can save your M and G Code files on your computer. 
Clicking on the Change button allows you to navigate to another location on your hard drive where you 
can save as well as Make New Folder and save there as well. 
 
It is highly recommended and necessary that the folder for saving G code files be created in the 
root directory of the main hard disk drive (most of the time C:\). 
 
It is also highly recommended and necessary to limit the name of the file to 8 characters plus three 
characters after the dot. (An example – myGcode1.ngc) 
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To Generate and Save G-Code file simply click Print from your design application and it will save the 
file.  When you are saving the M and G-Code file, you can select the location where you are saving this 
file by going to Location for saved file in General options tab of LinkMotion. Also select None in 
Send file to port selection in General options tab. You can open the file and edit the file in Microsoft 
NotePad, Microsoft WordPad, Microsoft Word, or many popular text editors. 
 
User can change the extension to the saved G code file by making a change in the LinkMotion.ini file as 
follows: 
 
Windows 10, 8, 7 32/64 
 
User can also select the file extension name by following setup in Win 10, 8, 7. 
 
Find a file name LinkMotion.INI from the following location: 
In the C:\ Program Data > Solustan > LinkMotion > LinkMotion.INI. 
 
Double click on this file and windows NotePad should open this file. Scroll down until you fine a line 
name “GcodeFileExtension=.txt” under your selected machine (printer installed name) name. 
  
Here you can change from .txt to extension required by your machine controller like .plt, .cnc, .ncd, 
.tap, .ngc, etc.   
 
Windows XP  
 
User can also select the file extension name by following setup in Win XP. 
 
Find a file name LinkMotion.INI from the following location: 
In the C:\ Documents and Settings > All Users > Solustan > LinkMotion > LinkMotion.INI.   
 
Double click on this file and windows NotePad should open this file. Scroll down until you fine a line 
name “ GcodeFileExtension=.txt” under your selected machine (printer installed name) name. 
 
Here you can change from .txt to extension required by your machine controller like .plt, .cnc, .ncd, 
.tap, .ngc, etc. 

 
Send file to Port: 
 
If you are simply saving M and G-code file from any design application and if you do not intend to send 
the file through a port, you need to select None here.  
 
If you plan to save and send the file through one of the COM Ports, select a port.  Choices are COM1, 
COM2, COM3, and COM4. Windows will display COM Port only if you have them on your 
computer and COM properties only when a device is attached to it. 
 
After selecting the port of choice, make sure and set the parameters of the port to match with the CNC 
controller that will receive the job file. The process is slightly different for different versions of the 
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Windows operating systems.  
 
 

 
 
 
Windows 10, 8, 7 32/64 
 
Select Control Panel from windows Start button.  
Select Hardware and Sound.  
Select Device Manager from Devices and Printers.  
Double Click on Ports (COM & LPT) (Port information is displayed only if a device is connected). 
Double click on the COM Port where your controller is connected.  
Select the tab for Port Settings.  
Set proper settings for Bits per second, Data bits, Parity, Stop bits, and Flow control as specified by 
your controller manufacturer.  
Click OK to save those settings. 
 
Windows XP 
 
Select Control Panel from windows Start button.  
Double click on Administrative Tools.   
Double click on Computer Management.  
Select Device Manager on the left.  
Double Click on Ports (COM & LPT) (Port information is displayed only if a device is connected). 
Double click on the COM Port where your controller is connected.  
Select the tab for Port Settings.  
Set proper settings for Bits per second, Data bits, Parity, Stop bits, and Flow control as specified by 
your controller manufacturer.  
Click OK to save those settings. 
 
Now your G-Code file from your design application will be saved and sent to your controller. 
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Help: 
 
 

 
 
 
Use Online Documentation  
 
Checking this button takes you to our website where you can get most PDF documents for support. 
 
Different buttons are created for help however more up-to-date manuals in PDF formats are provided 
with the respective LinkMotion version you receive. It is not updated here. 
 
After installing LinkCAM software  user needs to double click on the LinkMotion Icon on the systems 
tray at the bottom right. Here click on the Help Tab and you will see the following picture. 
 
LinkCAM in Demo Mode: 
 
LinkMotion/LinkCAM for M&G code software works in a Demo mode until sofware license 
procedure is completed. Demo mode has limitation of generating up to approximately 100 lines of 
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GCodes from the design applications. It will not generate after it reaches 100 lines in one job. In demo 
mode only up to 140 lines of previously generated gcode files can be processed using GCode Files tab. 
If code generated is larger then user will see the following message: 
 
 

 
 
 
User needs to send proper Hardware ID that you read here to support@solustan.com. You can use 
windows copy and paste method or make sure you send it to us without any error.  
 
Solustan will not be resposible for any errors generated by user. It will cost you extra in case of an 
error where we need to generate sofware key more than once. 
 
We will send back the Sotware Key code that you will place in the secon box and then click on the 
button for Register. You will see the following screen once license is registered. Now sofware will work 
with all functions properly. Following picture shows software without full license. 
 
 

 
 
 
Once you receive a license key code from Solustan and it ets registered it should display as seen in the 
following picture. 
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Now start using the software and enjoy generating gcode files. 
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Application Compatibility with LinkMotion: 
 
Go to www.solustan.com/support and download instructions for the appropriate design 
application you might be using. Some applications have their own limitations and mostly it is 
listed in the document. We are adding information as we test with respective applications. 
 
Solustan tests the primary function of accepting hair lines (vector lines) from the third party 
application software to make the vector moves on the machine using LinkMotion driver.  Solustan 
may test additional functions. However, it is not a detailed testing. The developer and marketer of 
the third party software make changes to their applications quite often. It is the responsibility of 
the user to make sure that the necessary functions are available while making the choice of off-the-
shelf application software. 
 
Solustan's liability is limited to the purchase price of the LinkMotion driver software. 
 

1. Corel Draw version 9, 10, 11, 12, X3, X4, X5, X6 and X7 
 

2. Corel Paint Shop Pro (Raster Only) 
 

3. Adobe Illustrator 
 

4. EngraveLab / SignLab version 6.0 and higher 
 

5. FlexiExpert 
 

6. FreeHand MX 
 

7. Gerber ArtPath and Composer 
 

8. Vinyl Express 
 

9. Xenetech 
 

10. AutoCAD version 2000 and higher 
 

11. DesignCad 
 
12. DolphinCAD specially designed version for LinkMotion 

 
13. Turbo CAD 

 
14. Instant Engineer 14 

 
15. Rhino 4.0 Beta 

 
16. IntelliCAD (AcceliCAD) 
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17. BarTender (Raster only) 

 
18. Microsoft Word (Raster only) 

 
19. PhotoShop (Raster only) 

 
20. MaxMotion – Windows XP and 2000 (Not supported in Vista, Win 7 32 or Win 7 64) 
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Frequently Asked Questions: 
 
 
Section I - Microsoft Windows configuration related questions: 
 
 
1.  What is the minimum configuration required for the PC?  
 
Windows 10, 8, 7 32 or 64bit or 
Windows XP operating system with Service Pak 2 or higher and Microsoft .NET 2.0 Framework 
installed, Processor speed of at least 800 Mhz, Minimum RAM memory 512 MB, 1 GB preferred. 
40 MB of Hard drive free space, Screen resolution of at least 800 x 600. 
Service Pak and .NET 2.0 Framework are (free) downloadable from Microsoft’s website. 
CD-ROM drive is not required, if the driver software was down loaded from the internet. 
CD-ROM drive is necessary, if the software was received on a CD. 
 
2.  How to check if I have installed Service Pak2 for Win XP on my computer? 
 
Go to the Start button. Select Control Panel. Select System. Now in General menu it should show if 
Service Pak 2 is installed. Also you can install and uninstall by windows standard Add/Remove 
program procedure. Make sure you install LinkMotion after you install windows operating system 
related update first. 
 
3.  How to check if I have installed .NET Framework 2.0 for WinXP on my 
computer? 
 
Go to the Start button. Select Control Panel. Select Add/Remove programs. Here you should see if 
you have installed the .NET Framework 2.0 of Microsoft. This is required to work with our new 
version of LinkMotion. 
 
4.  How can I check the processor speed and RAM memory on my PC? 
 
Go to the Start button on the System Tray on the bottom left and select Control Panel. Select System 
from the Control panel. Here you should see information for the version of your operating system and 
under Computer you should see the processor speed and the RAM memory installed on your computer. 
 
5.  How to see hidden folders in windows?  
 
Windows 10, 8, 7 32/64: 
Go to Control Panel and click on the Appearance and Personalization. Under folder Options Click on 
the Show Hidden files and folders. Here check the button for Show hidden files, folders and drives in 
the middle section under Hidden files and folders. Click on the Apply button. Click on the OK button. 
Now you are done with all setup procedure for installation. 
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Windows XP: 
Go to the Start button. Select Control Panel. Select Tools Menu and select Folder option. Click on the 
View menu. You should see a folder called Hidden files and folders. Here select the button for Show 
hidden files and folders. Click on the Apply button. Now you will see all the folders. This is useful to 
see the configuration file name LinkMotion.INI for LinkMotion driver application. 
 
 
Section II - LinkMotion Driver: 
  
 
1.  Do I need to access LinkMotion driver software once loaded? 
 
Mostly, not and generally you simply deal with your off-the-shelf job design software and your 
machine. We do provide an accompanied applet for changing the settings. This application can be 
invoked from its icon in the System Tray area. This application will allow you to choose settings by 
going to different tabs (menu) like Material Properties, Machine Properties, Origin setup and Motion 
Control Boards. Make proper selections, click on the apply button and then start the design application. 
 
2.  How do I know if my LinkMotion is installed properly? 
 
When you launch LinkMotion applet does it show the title “LinkMotion for RS/274 M&G-Code – 
Ver. X.X.X” (version that you have). If this is not proper you may have installed for the wrong 
machine. You need to uninstall and re-install LinkMotion again by windows standard uninstall 
procedure. 
 
If you had a trial version you need to purchase the full working version.  
 
3.  How to see the file for my LinkMotion related configuration settings?  
 
This file is named LinkMotion.INI. This file has all your machine related settings. You can save this 
file under different name as well as reload this file from where you might have saved this file. 
 
Windows 10, 8, 7 64/32: 
Go to your C:\  > Program Data > Solustan > LinkMotion > LinkMotion.INI. 
 
Windows XP: 
Go to your C:\  > Documents and Settings > All Users > Solustan > LinkMotion > LinkMotion.INI. 
 
4.  I want to design in millimeters and not inches. How do I change? 
 
Simply go to the General Options tab and change from inches to mm by clicking on the scroll down 
arrow and then click on the Apply button. Similarly you can change to cm also. It is that easy. 
 
5.  I have selected Print to File and nothing is happening. What am I doing wrong? 
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Print to File is necessary to use only for Win XP version. If you have Win 7 32/64 version then it can 
create blank file. Under Win XP this situation may occur due to any of the following: 
 
(A) Check if you have checked the button for Print to File. 
 
(B) Check the print queue for any extraneous documents and delete them before creating new file. 
 
(C) Check the job feed rates and other settings to make sure that they are all correct. 
 
(D) Printer driver installed for your machine may not have been selected as DEFAULT DRIVER. 
Either you can decide to remember and select proper driver every time or select the appropriate 
LinkMotion driver as the default driver. Please check in Control Panel>Printers and Faxes>Your 
Machine Driver (this should be selected as default driver).  
 
(E) You might have selected thick outline or filled object in your design. There should be No fill (not 
even White fill) to send the job to a vinyl cutter. Use only Hairline thickness of lines for any job 
you design with graphics or text. If you sent the file for print by mistake with thick line or the 
filled object, go down to windows print spooler and make sure you delete the file properly before 
sending the new corrected file. 
 
(F) If Service Pak 2 was not installed on your Windows XP operating system you may see the 
problem of LinkMotion not sending anything to the machine. You need to uninstall the LinkMotion 
and then install the Service Pak 2 and re-install the LinkMotion driver software. 
 
(G) Make sure to design the job within the size of working area available with your machine table size. 
 
6. Can I preset or change the values for the speeds of operation for different 
materials? Where and How? 
 
Launch LinkMotion from Systems Tray. Go to Material Properties. Set values for Job Feed Rate of 
operation for different materials. Click Apply and then Print to File again. Read the details in the HELP 
tab under the chapter Using LinkMotion or LM&M&G-Code.PDF. 
 
7.  I have setup and customized LinkMotion for my needs. Now, you sent me 
information for new version of LinkMotion. How can I preserve my settings while 
upgrading to a new version? 
 
It is very easy. Follow the uninstall instruction (from the end of the document) from installation 
instructions. Remember to first save your older configuration file and then uninstall. Now install the new 
version and bring back you older configuration file from General Options tab by Load button. Re-
Launch LinkMotion driver one time and then work with your new version. 
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Section III - LinkMotion and Design Applications: 
 
 
1.  How can I change starting positions of a job? 
 
Starting position is controlled by your design application as well as what you have selected in Start 
Position under Origin Setup of LinkMotion. Please read and understand functions of both 
applications from their help section before using it. 
 
2.  Why is my job being cut goes back and forth all over the machine? 
 
Most design applications generally will output jobs in the order that it was designed. If you wish to see a 
different order then you need to use sorting available from the Design Application. Please check your 
design application functions. LinkMotion and specific Design Application document has more detail 
explanation. 
 
3.  How can I design a job in different colors or layers? 
 
These functions are available from the design Applications. Please check the document of your design 
application or the document name LinkMotion with popular applications. 
 
4.  How can I duplicate my design to cut several times? 
 
These functions are available from the design Applications. Please check the document of your design 
application or the document name LinkMotion with popular applications. 
 
5.  Can I cut the same job again since it was not cut all the way (depth) properly? 
 
User should always do preliminary testing for proper depth and then send the job for production. 
Following conditions will allow you to cut the job again. 
  
Check the box under Origin setup for Return to 0,0 after job. This allows your tool to be parked back 
in the same position as before.  
 
Make sure to make changes in the depth selection of Material Properties, Click on the Apply button 
for it to be effective.  
 
Now you can select the object or the shapes that did not cut properly and send it again to the machine.  
Make sure to look at the preview before you create the file for roper location of the output. 
 
Make sure that proper M & G-Code is generated. 
 
6.  Can I cut any part of the job again without sending a complete job again? 
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This is dependent on the capabilities of the design application’s print driver capabilities. Corel Draw has 
this capability and you can make selection of the shapes you wish to send and then in the final print 
dialog box check selection for output and only selected shapes will go out for final output. 
 
7.  Can I use any design applications to save my job? 
 
Yes, you can use other applications as long as the design application is capable of sending a vector 
output file. Design application should allow you to design shapes with thinnest line or hairline or zero 
line width and no fill. Word processing type applications are not capable of sending the vector output.  
Please check with us or your supplier for more information. We document the one we do testing with. 
 
8.  What can I do to get more help? 
 
Support is freely available by email – support@solustan.com 
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